Petroleum Assays

» PETROLEUM AssAY MANAGEMENT:-

The new Assay Management features in Aspen HYSYS Petroleum Refining allow users to use the same
assays in Aspen HYSYS Petroleum Refining and Aspen PIMS, get better results for crude modeling using
the improved characterization and property calculations of Aspen Assay Management, and access an
extensive database of crudes and crude properties with the new assay library, and easily import data from
other sources.

To use the Petroleum Assay Management we need to access the “Petroleum Assays™ in the Properties
Environment by:

- Click “Petroleum Assays” in “Home” tab in the Ribbon.
- Click “Petroleum Assays™ in the navigation pane.
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i. ADDING A NEW ASSAY:-

Under Petroleum Assays, you can add a new Assay by clicking the dropdown arrow and select one of
the three methods available:

o Import from Library: Select an assay from the Assay Library.

o Import from File: Import a supported Excel, CSV, or AFAM case with assay data.

o Manually Enter: Manually enter data into the Assay Table.
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1.1. IMPORT FROM LIBRARY:

You can add pre-characterized assays from the HYSYS Petroleum Refining assay libraries.
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1.2. IMPORT FROM FILE:
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Aszay data format:

Assay files

1.3. MANUALLY ENTER:

By choosing “manually enter”, the New Assay dialog box appears where you enter a name for the new
assay in the New Assay dialog box, and select a Fluid Package to apply to the assay. You can pick one

from the list or click <Create New> to create a new one.

Note: If no fluid packages have been created for the new assay, HYSYS automatically creates and
attaches a preset petroleum fluid package to the assay with default components and hypotheticals. This
applies to all options to create a new assay unless you import a .CSV file or a third party assay.

Then, Select the assay type: Multi Cut Properties, Single Stream Properties, or Back Blending.

1.3.1. MULTI CUT PROPERTIES:
Multi Cut Properties - lets you enter cuts with their initial and final boiling pomts.

This 1s ideal if you have data for specific assay cuts that you wish to enter, such as Cut Yields.
Here, you can set the number of cuts from your data and enter the boiling point ranges in the

table provided.



Name: Assay -1 " Fluid Package: Basis-1

@ Multi Cut ngrﬁes\gjﬂu mber of Cuts: 5
|

) Single Stream Properties You can change
the No. of Cuts

() BackBlending

Name¥ Initial BP(C) W Final BP(C) T
Cut 1 I8P 25.0000
Cut 2 25.0000 120.0000
Cut 3 120.0000 275.0000

Cut4 e 275.0000 375.0000
Cut5 375.0000 FBP

1.3.2. SINGLE STREAM PROPERTIES:

Single Stream - lets you define the distillation percent and temperature of individual streams.

This option 1s 1deal 1f you want to evaluate an assay from distillation data and bulk (whole
crude) properties to create a single-stream for your model.



Mame: Assay-1 0 Fluid Package: [Bash'-i e -

) Multi Cut Properties Number of Cuts: |5

@ Single Stream Properties \\3._,/

) BackBlending

Distillation % W) Temperature iy

TBP
By mass
o

By Right
( Click

Insert Row E
Delete Row

A In the Curve type row, specify the method used for distillation: TBP, D86, D2887 or D1160.
= Specify the Basis: By mass or By volume.
B. You can adjust the number of distillation Points by adding or removing Point.

After Adding the Assay Data Either with Multi-Cut or Single Stream, The “Input Assay™ Form
Displays ...

Use the Input Assay form to enter available expenmental assay data including properties, pure components
composition, and distillation data for different product cuts.

s Input Summary tab
Display property data for the whole crude and product cuts.
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+ Disiillation Data tab
Display distillation data, such as TBP or D86 curve, of the whole crude or any product cuts.
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1.3.8. BACK BELENDING:

Back blending - lets you define feed streams by blending their associated products. The nput
products are typically defined in commercial distillations that have significant overlap across
products. Backblending creates an assay from these overlapping measurements that can be used as a

HYSYS Petroleum Refining feed stream.

IBai'rs—1

Mame: Assay - 2 Fluid Package:

Number of Cut= |5

2 Mult Cut Properties

&) Single Stream Properties

@ BackBlending




After selecting Backblending. the Backblending Input Form appears on the navigation pane instead

of the Input Assay Form.
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» Light Streams tab
Enter the component percentage for each assay and the cut yield of the total blend of each cut. The

percentage of the same component on the light streams form and the heavy stream form should add
up to 100%; 1f not, the value need fo be normalized.
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+ Heavy Streams tab
Enter the distillation vield and property data for each cut.

Notes:

o At least 3 cuts in Heavy Stream are needed.

o In the Curve type row, specify the method used for distillation: TBP, D86, D2887 or D1160.
o Specify the Basis: By mass or By volume.

o You can adjust the mumber of distillation Points by adding or removing Point.

After All Data Has Been Added Using Any Method From The Previous Three Methods
(i.e. Multi-cut, Single Stream, or Back Blending), The Assay Need To be Characterized
By Clicking on “Characterize Assay”™ Button ...



2. CHARACTERIZING ASSAY:-
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Assay manager will take a few second to characterize the assay, when the characterization finishes. a
Conventional Results node will appear under the assay sub-node for each characterized assay. And the
status of characterized assays becomes Characterized Successfully on the Petroleum Assays form.
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The Conventional Results form consists of the following tabs:

Results Summary tab
Pure Component tab
Distillation fab
Property Table tab
Message tab

By defanlt, the Message tab displays all the irregulanities found during the assay characterization, such as
the violation of the minimum and maxinmm bounds of a property. Assay Management divides the
irregulanities into Error and Warning.

Use the Results Summany tab. Pure Component tab and Distillation tab on the Conventional Results
form in the same as for the three tabs of the Input Assay form (page 6-7).

Data changes on the Input Assay form after characterization, such as adding, removing or modifying cut
or/and property data, appear automafically on the Conventional Results form when the assay 1s re-
characterized. In addition, any new cuts or properties that have been added or modified on the Conventional
Results forms are retained.

Also after characterization, the Plot Gallery appears in the ribbon. These plots can be used to visualize the
quality of assay data, and to compare different assays and properties.

The Plot Gallery of the Assay Management ribbon contains the following plot types:

+ Distillations plot
v Properties plot
¥ Cut Viscosities plot
v Cut Yields plot
¥ PNA plot
¥ Viscosities plot
= H e Hohame e - Aspen HYSYS VBB - apenDME - 5 EEl
e . Cubonins A I Pamme || . ipnkayr FyTT r— B &
— = L= e Lapared " Doline E Pt
5"‘ i n Eeal 0 oy hee W 5
:'5:-! ¥l # Lhe ks Sde BokidTed  mmn vesph -
‘Ju:u._. T - Convantansl Rasir pw;:.lru;._m CTTE R tn-:uu-m1 O -
CAstAlations
Rl Attsy - 1WiTals Crudd BF - FOR —
& ey - 1 Faw Ouia
wd
=L wd
& Reainrs F
B Cormponr b i .
Urer Progastise z
- - T T T T T
IS ) Tarmparsrei C) i
Ll sty dadvi
,"i:l Farigy Racalyaic




To compare data from more than one crude assay, the second crude mmst be added, you can add it to the plot
by clicking “Select Assays™ under the Format tab when the Plot is selected.
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3. UsiNG AssAYs IN THE SIMULATION:-

When an assay has been created and characterized in the Properties Environment, it can be immediately
used for modeling in the Sinmlation Environment. To bring the assay into the simmlation, it must be either
attached to a stream or added to a Petrolenm Feeder unit operation.

3.1. ATTACHING ASSAY TO A STREAM.

If the assay will be modeled as a single-stream. you can typically attach it to a material stream in the
flowsheet. First, add a material stream fo the flowsheet. Then, open up the stream view by double-clicking
the newly created stream and click on the “Petrolenm Assay™ option in the Worksheet tab. In the Assay
form, select the Attach Existing option which will show a dropdown list where the previously created assay
can be selected. Once a characterized assay 1s attached, it will define the composition and the properties of
the stream so that the user just has to enter the conditions of the stream for 1t to be firlly defined.
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3.2. ADDING ASSAY TO PETROELUM FEEDER:

If more than one assay will be used or if the assay will be mixed with

another stream, they can be added to a Petroleum Feeder. In the Feeder,
you can select mput feed streams and feed assays (as well as mixing Dynamics
specifications including a fluid package) and Aspen HYSY'S will Columns
calculate a product stream that can be used in the flowsheet. I Refining I
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HYSYS OPTIMIZER

» INTRODUCTION: -

Optimization, in general, can be defined as the process, or methodology of making something (as a design,
system, or decision) as fully perfect, functional, or effective as possible: specifically: the mathematical
procedures (as finding the maximum of a function) involved in this.

That’s mean, we try - in optimization - to find the operating conditions which minimize (or maximize) an
Objective Function. This objective function expresses (Mathematically) the intended purpose behind the
process of Optimization.

For example, if we want to achieve the highest profit, it means that we want to reach the perfect (Optimum)
value of the operating conditions which achieve the highest profit without affecting the required quality thus,
the Objective function here is the equation that expresses the profit, any variable whose values are
manipulated in order to minimize (or maximize) the objective function are called Primary Variable, and
the required quality specification is a Constrain on the extent of change in the allowable values of the
variables.

So, Objective Function 1s created by studying the whole process with its all variables, conditions, and
constrains, and studying their relation with the desired goal of the optimization process.

HYSYS contains a multi-variable steady state Optimizer, the object-oriented design of HYSYS makes the
Optimizer extremely powerful, since it has access to a wide range of process variables for your optimization
study.

# To access the Optimizers:
= Select the Home ribbon tab | Analysis section | Optimizer icon.
or
= Press F5.

Use the Configuration tab of the Optimizer to select the Optimizer mode you want to run.



Configuration | Variables | Functions | Parameters | Monitor

Optimizer Configuration

Data Model
9 QOriginal
Hyprotech SQP
_) MDC Optim
Selection Optimization
) DMO
LSSQP
BOBYQA

] Online

Notes:

- There’re many different models of optimization, each differ in the method and algorithm that is used
mn solving the optimization, we will go through the default model which is the “Original™ model.

- The Optimizer is available for steady state calculations only. The operation does not run in Dynamic
mode.

» SETTING UP ORIGINAL OPTIMIZER: -

After choosing the optimizer model. we need to setup our optimizer before pressing “start” for starting the
solver of the optimization. The setup process goes through different steps in different tabs in the optimizer
window, we will discuss each one with details in the following sections.

¢ The Variables Tab:

On the Variables tab, you can import the primary variables which minimize or maximize the objective

function. Any process variable that is modifiable (user-specified) can be used as a primary variable. (Only
user-specified variables can be used as Primary Variables.)
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Configuration | Variables | Functions | Parameters | Monitor |
~ Adjusted (Primary) Vanables

Object Variable Description Low Bound Current Value High Bound Reset Value Enakled
Reactor Prods Temperature 30.3G 60.00 120.0 <empty> ol

Each primary variable has the following values:

- Low Bound: The Lowest value that optimizer can assign for the variable for solution.
- High Bound: The Highest value that optimizer can assign for the varable for solution.
- Current Value: The Current used value for the variable in the simulation.

In general, the primary variables should not be part of the Objective Function.

¢ The Functions Tab:

| Configuration | \I‘ariablesl Functiu-nsl Parameters | Monitor |

Cell o ) Minimize

Current Value cempty> ) Maximize

Constraint Functions e

Mur | LH5 Cell Current Value | Cond | RHS Cell Current Value | Penalty Value Add

y

recree | S | -

In the functions tab we specify the following (according to the above numbering in the picture):

1- Specify the cell in the Spreadsheet that represent the Objective Function.
2- Choose whether we need to maximize or minimize that objective function.
3- Specify the cells in the Spreadsheet that represent the Constrains Function.
Any constrain function is represented in the form of
Left hand side condition Right Hand Side
a. Click Add to add a new constrain. (a new constrain row will be added).
b. Under LHS Cell, select the cell from the spreadsheet that represent the Left side of the
constrain function.
¢. Under Cond. select the proper condition between the right side and left side (c.g. =, =, <)
d. Under RHS Cell, select the cell from the spreadsheet that represent the Right side of the
constrain function.



The Optimizer Spreadsheet

It’s clear from the above sequences that in the functions tab we don’t create the functions (objective or
constrains) in that tab instead, we just select a Cell in the spreadsheet which has the function created in it.

For that reason, we must go through the spreadsheet to know how to build our functions before continue
with the remaining Optimizer Tabs.

The Optimizer's Spreadsheet is identical to the HYSYS Spreadsheet operation; process variables can be
attached by dragging and dropping, or using the Variable Navigator. Once the necessary process variables
are connected to the Spreadsheet, you can construct the Objective Function and any constraints using the
standard syntax.

We can access the Optimizer’s spreadsheet by clicking the “SpreadSheet” button that locate in the bottom of
each tab of the optimizer.

— Connections Tab:

Connections | Paramcters | Formulas | Spreadsheet | Calculation Order | User Variables | Notes

Imported Variables

ICeII Object Variable Description [ Edigimpors ]

A1l Prop Oxide Mass Flow

The Cell in Spreadshest The Imported
that contain the value ofj Vari!:ble

the Imported Variable.

 Exported Vanables

Cell Object Variable Description
Add Export...
[ Function Help... ] [ Spreadsheet Cnly... ]

[C] Ignored

You can import virtually any variable in the simulation nto the Spreadsheet, and you can export a cell's
value to any specifiable field in your simulation.

There are two methods of importing and exporting variables to and from the Spreadsheet:

1. Using the Variable Navigator:
a. On the Connections tab, click the Add Import or Add Export button.
b. Then using the Variable Navigator, select the variable you want to import or export.

2. Drageing Variables:

Simply right-click the variable value you want to import, and drag it to the desired location in
the Spreadsheet. If you are exporting the variable, drag it from the Spreadsheet to an
appropriate location.



After importing variables, In the Cell column, type or select from the drop-down list the Spreadsheet cell to
be connected to that variable. When you move to the Spreadsheet tab. that variable appears in the cell you
specified. (see previous figure).

— Parameters Tab:

On the Parameters tab of the Spreadsheet property view, you can set the dimensions of the Spreadsheet and
choose a Unit Set.

I4) Spreadsheet OptimizerSpreadsheet

| Connections I Parameters IFarmuIa-; Spreadsheet I Calculation Order | U=zer Variablez I Nmesl

-Spreadsheet Parameters - Dynamic Execution
Mumber of Columne 4 Eefore Praccure-Flow Step =
Mumber of Rows 10 After Pressure-Flow Step r
Units Set Field Each Composition Step -
Alway Update Exports -
| Exportable Cells (Visible in Spreadsheet’s Varnable List)
Cell Yisible Mame Wariable Name Variable Type
Bl B1: Caost Per Volume
B2 B2: Cost Per Volume
B3 B3: Cost Per Volume
B4 B4 Cost Index per Energy
BS BS: Cost Index per Energy
C1 C1:
c2 c2:
C3 C3:
c4 C4:
C5 C5:
cT CT:
Function Help... ] [ Spreadshest Only.. [ lgnomed




— Formulas Tab:

The Formulas tab displays a summary of all the formulas included in your spreadsheet. The table lists the

name of the cell the formula is located in, the formula and the result of the formula.

H Spreadsheet: OptimizerSpreadsheet

| Connections | Parameters Spreavdsheet | Calculation Order I User Variables | Motes |

Formula Summary

Cell Formula Rezult
c1 +A1"B1 4008
c2 +AZ*B2 1.425e+004
c3 +A3"B3"24 -217.0
c4 +a4"B4724 837.3
Lo +AS*B" 24 938.3
c7 +C2-C1-C3-C4-C5 7692

[ Function Help... l [ Spreadsheet Only...

—> SpreadSheet Tab:
The Spreadsheet tab is similar to conventional Spreadsheets (e.g. MS Excel).

| Connections | Parameters | Formulasl Spreadsheet ICaIculation Order | User Variables | Motes |

ICunen: Cell

I Function Help... ﬁ [

Imported From: [Prop Cxide | Exportable []
Variable: |Stc Ideal Lig Vol Flow The \-’ariabld Angles in: | | [ Edit Rows/Columns
Name

A B c D ml
1 714.1 barrel/day 7.000 Cost/bbl 4998
2 712.4 barrel/day 20.00 Cost/bbl 1.425e+004
3 -4.520e+006 Btu/hr  2.000e-006 Cost/bbl -217.0
4 1.744e+007 Btu/hr  2.000e-006 Cost/Btu 837.2 =
5 1.955e+007 Btu/hr  2.000e-006 Cost/Btu 8938.2
6
7 7697
B
. L
10 -

Spreadshest Only..

[flgnored

[] ignored




The Current Cell group displays information specific to the contents of the highlighted cell.

- Ifthe Cell contain an imported value: The object and variable from which the contents of the
current cell were imported are shown. You cannot change the Variable name, since it 1s a HYSYS

default.
~Current Cell
Imported From |Pmp Oxide | Exportable

v'ariable: |5.n:| Ideal Lig Vol Flow | Angles in:

- Ifthe Cell contain a specifiable value: The Variable Type and Variable Name are shown. You can
choose a new Variable Type from the drop-down list. and you can edit the Variable name.

~ Curmrent Cell
Variable Type: Cost Per Volume "‘ Exportable

E2 Variable: Angles in: |




The HYSYS Spreadsheet has extensive mathematical and logical function capability.

The Available Expressions and Functions property view contains the following tabs:
- Mathematical Expressions
- Logical Expressions
- Mathematical Functions

Note: All functions must be preceded by “+7 (straight math) or “@" (special functions like logarithmic,
trigonometric, logical, and so forth).

To view the available Spreadsheet Functions and Expressions, click the Function Help button to open the
Available Expressions and Functions property view.

Most Common Used Operations
Addition Use the “+" symbol.
Subtraction Use the "-" symbol.
Multiplication Use the “*” symbol.
Division Use the */” symbol.
Absolute Value “@Abs™.
Power Use the “*” symbol. Example: +373 =27
Square Root "@SQRT". Example: @sqrt(16) =4
Pi Simply enter "+pi" to represent the number 3.1415...
sin @S]IIO
cos @cos()
tan @tan()
sinh @S].Ilho
cosh (@cosh()
tanh (@tanh()
Ln @)




¢ The Parameters Tab:

The Parameters tab is used for selecting the Optimization Scheme and defining associated parameters.

I4) Optimizer

Configuration | Variables Fundionsl Parameters | Monil.or|

- Optimizer Parameters

Scheme Mived
Maximum Function Evaluations 300
Tolerance 1.000=-05
Maximum [terations 30
Maxirmum Change/lteration 0.3000
Shift A 1.000=-04
Shift B 1.000=-04

Coome ) [ oomrce. | A | -

Summary of the Optimizer Schemes
Calculates
Unconstramned Constramned Problems: Constramned Problems: o
Method i i Dertvatives
Problems Inequality Equality

BOX X X
Mixed X X X
SQP X X X
Fletcher-
Reeves X x
Quasi-
Newton X X




¢ The Monitor Tab:

The Monitor tab displays the values of the objective function, primary variables, and constraint functions
during the Optimizer calculations. New information is updated only when there is an improvement in the

value of the Objective Function. The constraint values are positive if inequality constraints are satisfied and
negative if inequality constraints are not satisfied.

|4} Optimizer

Configuration | Variables | Functions | Parameters Monitor|

~Optimizer Monitor Information

Iteration Cum. Func. Eval. Objective Function Temp[zatl.lre Constraint 1
4,00000 5.00000 8571.94 106.200 -
3.00000 2.00000 8569.00 105.000
2.00000 4.00000 83068.98 105.000 J
1.00000 2.00000 8303.82 75.0000 1

e e




